# Table of Contents

## CHILD CHECK IN OVERVIEW
- Check In / Out Process ................................................................. 3
- Check In Methods ........................................................................ 3
- Name Tags and Security Tags ....................................................... 5
- Check Out .................................................................................. 6

## INSTALLING ROLL CALL for CHILD CHECK-IN
- Hardware/Software Requirements .............................................. 7
- Roll Call Software Installation .................................................. 7
- Check in Station Hardware Installation ..................................... 8

## CONFIGURING CHECK-IN
- Using the Setup Assistant ........................................................ 10
- Using the Setup Menu .............................................................. 12
- User Security and Check In Users ............................................. 13
- Name Tags & Parent Tags .......................................................... 19
- Check In Preferences .............................................................. 21
- Groups .................................................................................... 22
- People ..................................................................................... 23
- Key tags .................................................................................. 24

## OPERATING THE CHECK IN STATIONS (Computer Stations)
- Log into the Check In Station .................................................... 25
- Check In Using a Last Name ....................................................... 25
- Check In Using a Phone Number .............................................. 27
- Check In Using a Touch Screen ................................................ 31
- Check in Options ....................................................................... 32
- Add a New Person into an Existing Family ............................... 35
- Check in Visitors ....................................................................... 36
- Check In by Individual Using a Last Name or Phone ................. 38
- Check In by Individual Using a Bar Code .................................. 40
- Check into Services ................................................................. 41
- Determine Headcounts ............................................................. 42
- Check Out ................................................................................ 43
- Sending Texts from Check In Screen ....................................... 45

## OPERATING THE CHECK IN STATIONS (Tablets)
- Log into the Check In Station .................................................... 49
- Customizing the Appearance .................................................... 49
- Check In Using a Last Name or Phone Number ....................... 50
- Check in Options ....................................................................... 52
- Add a New Person into an Existing Family ............................... 56
- Check In by Individual Using a Last Name or Phone ................. 56
- Check in Visitors ....................................................................... 59
- Check In by Service ................................................................... 60
- Check In by Keyword ............................................................... 62
- Determine Headcounts ............................................................. 62
- Check Out ................................................................................ 63
- Sending Texts from Check In Screen ....................................... 65
Check In / Out Process
The child check in system in Roll Call allows you to check students into their classes, record attendance and print name tags and security labels. This system can be used to check people into any groups/classes or worship service that is defined in Roll Call.

Check In Methods
When the student arrives to check in, the first thing you need to do is identify that student or family. You can identify them in a variety of ways. These methods are discussed below.

Key Tags
Probably the most popular method for checking students in is to issue key tags to the parents. These key tags can be customized to have your church or ministry logo on the front and a bar code on the back. The bar code number is assigned to mom, dad or the individual student. Key tags can be used to check students in an unmanned station or a manned station.
Bar Code Badge

Another option for using a bar code scan to check students in, is to print a bar code badge from Roll Call. These badges are printed on an 8 ½ x 11 sheet of paper or on Avery business card stock. Once you have the badges printed, you can laminate them and issue to the families. Badges can be used to check students in using an un-manned station as well as a manned station.

Name, Phone, Family Number

If you do not want to scan a bar code, you can use the keyboard or a touch screen monitor to identify who is here to check in. You can type in the last name, last 4 digits of the phone number or a family number. The person manning the check in area simply types the last name or number, then selects the student from the list. Typically when checking in using a name, phone number or family number a volunteer will be manning the check in station.

Finger Vein Scan

Another option for identifying who is here to check in, is the fingervein scan. This option is only available on the Windows platform. This mode of check in can be used on an un-manned station or a manned station.
Mobile Device

With a Mobile CheckIn license, you can check in using an iPad, iPod, smart phone or other tablet. You can check in students by name or phone number. The name tags are printed in a central location where Roll Call is running as a print queue user.

If you’d like to record attendance but not print labels, you can check in by group or by keyword. This will return a list of people in that group, and you can mark them present from this list.

Name Tags and Security Tags

Once the student checking in has been identified and checked into their class, name tags and parent tags can be printed.

The Roll Call system requires a Dymo Labelwriter 450 or 450 Turbo to print the labels. We support two different size labels. The first is a smaller label (30334). Your church can also opt to use the larger 30256 label. This option gives you more flexibility as to the information included on the label. Your logo can also be printed on this label.

A parent or security tag can also be printed. This tag will only include the security number on it. There will be no information about the child on this tag. The parent brings this tag to the classroom to pick up their child. The teacher will compare the numbers on the child’s name tag with the number on the parent tag. If they match, the teacher can release the child.
Check Out

To check a child out using the Roll Call system, you will need to once again identify that child. The station operator will see that the child is checked in, they can click the button to check them out of that class. If there are any custody comments for this child, they will be displayed when the check out button is pressed. If your church has indicated authorized person’s for check out, the check in station operator will need to mark the person who is checking the child out.

We’ve found that most churches do not check out using the system. They compare the security code on the parent tag with the code on the child’s tag to determine if the child can be released.
INSTALLING ROLL CALL for CHILD CHECK-IN

Hardware/Software Requirements

Roll Call workstations
If you will only be using one check-in station, you’ll want to install Roll Call Standalone. If you will be using multiple check in station, each “kiosk” needs to have a computer with Roll Call Client. That computer must have a network connection so that it can connect to Roll Call Server.

Bar Code scanner
If you will be checking students in using bar code technology, each check-in station will need a bar code scanner. The scanner needs to be a keyboard wedge device with the ability to scan a single digit. We recommend the Voyager CG hand held scanner. These scanners may be purchased through By the Book.

Dymo LabelWriter
This printer is required if you wish to print labels for the child and parent upon check in. The program is expecting a Dymo LabelWriter 450 or 450 Turbo printer. You may choose from 2 different label sizes, the 30256 shipping label or the 30334 multi-purpose labels.

Brother Wireless Label Printer (QL-710w)
This printer is an option if you will be using Mobile CheckIn and would like to print the nametags and parent tags to a wireless printer. The brother label stock that we support is the 66 mm x 100 mm size.

Finger Vein Scanner
If you will be checking students in using biometrics, you’ll need the M2Sys finger print scanner connected to a Windows version of Roll Call.

Finger Vein Software
If you’ll be checking students in using their fingerprint, you’ll need the M2Sys finger vein software installed on a Windows computer.

Roll Call Software Installation

Single user version
The single user version of Roll Call allows one user, on one computer to access Roll Call. For the single user installation, use the following instructions.

To install Roll Call double click on the Roll Call installer file you downloaded. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Once the installation is complete, you will have a Roll Call icon on your desktop. If you are a Mac user, you will need to drag the application to your dock. To use Roll Call, double click on that icon.

Network Version
A network installation of Roll Call allows multiple people to access the data. If you have a multi-user license, multiple users can access the data simultaneously. For example, if you want to have 3 check in stations, you will need to use the network version of Roll Call so all 3 stations are
looking at the same information.

For the network installation, you will need to have your computers networked together. You will need to install Roll Call Server software on the computer that will house the database. You will need to install Roll Call Client software on all computers that need access to the data.

To install Roll Call Server double click on the Roll Call Server installation file. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Once the installation is complete, there will be a Roll Call Server icon on the desktop. To start Roll Call Server, double click on the icon. For users to work in Roll Call the Server must be running.

To install Roll Call Client double click on the Roll Call Client installation file. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Once the installation is complete, there will be a Roll Call Client icon on the desktop. To start Roll Call, double click on the icon. The Client will see Roll Call Server running on the network and connect to it.

**Check in Station Hardware Installation**

In a network environment, each check in kiosk should have Roll Call Client installed with access to Roll Call Server. In a single kiosk environment, the station should have Roll Call standalone installed.

**Bar Code Scanner**

If will be using bar code technology to check student’s in, plug the scanner into a USB port on your check in station. You can confirm that the scanner is working properly by scanning a bar code from a badge or key tag while you are in Text Edit (Mac) or Notepad (Windows) If this number pops into the page, the scanner is working properly.

**Dymo Labelwriter**

If will be printing labels as name tags and/or security labels, plug your Labelwriter into a USB port. Make sure to install the printer drivers.

If you are on a Windows machine, go to Printers and Faxes at the operating system level and choose properties for the Dymo Labelwriter. Click on Printing Preferences. For the 30334 labels, click Portrait. For the 30256 labels, select Landscape.

If you are a portable church, or are plugging the Labelwriters in each Sunday, please note, on some Windows machines, a new printer definition is created each time you plug in the printer. Make sure you only have ONE Labelwriter printer definition and that it is online.

**Brother Wireless Label Printer (QL-710w)**

If will be using Mobile CheckIn (iPads, Tablets or Smartphones) for check in, you may choose to print your labels on a Brother wireless printer. You will need to install the print drivers for each Brother printer on a computer that will be logged into Roll Call during your check in timeframe. You can define multiple brother printers on a single computer, but make sure to give them unique names.
**Finger Vein Scanner**

If you will be using the finger print scanner, plug the scanner into a USB port on your Windows check in station. Make sure that the biometric client software is installed on your check in station. See installation instruction for the biometric client and server from M2SYS.
CONFIGURING CHECK-IN

There are several ways to configure the check in system. You can use the set up assistant that is presented when you start Roll Call for the first time. This set up assistant will walk you through setting up the basic information required to use check in. The other option is to use the Setup menu under the CheckIn/Out menu in Roll Call. This set up wizard is a more complete method and will give you more options.

Using the Setup Assistant

When you start Roll Call for the first time, you will be asked a series of questions about how you will use Roll Call. This series of questions is called the Setup Assistant. You can also get to the setup assistant from the Administration top menu. For the purposes of this manual, we’ll start with the questions regarding Check In. If you answer Yes that you will be using Check In, you will be taken through this series of steps.

Security

To use Roll Call’s check in system, you must “sign into” the system as a check in user. You should have been asked to give Administrator a password as part of the Setup Assistant. This is what activates the security system. If you did not complete this step, click on the PREV button to do that.

Check In Users

To add a check in user, enter the following information:
1. **Username** – enter the name for this specific check in user.
2. **Password** – enter a password for this specific user or leave it blank.
3. **Confirm** – re-enter the password if you entered one.
To move on to the next step in the set up assistant, click NEXT.

**Check In Background**
Mark the image you’d like for the background of the check in screen. You may choose one of these images or click custom to pull in your own graphic.

![Check In Background Image Selection](image)

**Check In Groups**
Check In Groups are the events, classes or meetings that you will be checking people into. To define a group, enter the following information:

1. **Name** – the name of the group you are setting up.
2. **Day** – the day of the week that the class, meeting or event happens.
3. **Start Time** – the time that the class, meeting or event begins.
4. **End Time** – the time that the class, meeting or event ends.
5. **Grade or Age** – is this class, meeting or event limited to people in a certain grade or age range. If so, choose Grade or Age.
6. **Grade range** – if the class if for students in a certain grade, enter the “from” and “to” grade.
7. **Age range** – if the class is for students of a certain age range, enter the “from” and “to” age.

![Check In Groups Input](image)

Make sure to hit the plus sign to save the class and add another.
Check In Printing
The next question asks if you would like to print name tags when someone checks into a class, meeting or event. If you do, mark the option for Yes.

Next, you’ll be asked if you’d like to print a parent tag. If you would like to print a security tag that can be used for pickup, answer Yes.

Once you’ve gone through these steps, you will now be able to use the check in system. If you need to further refine the options for your check in users, customize what you’d like printed on the name tags or choose a different size label size, you’ll want to go to the Set up menu under CheckIn/Out to make those modifications.

Using the Setup Menu
The second method for setting up the check in system is to use the Setup menu under the CheckIn/Out menu on the left side. This method will give you the most options when configuring your check in users, name tags, groups and keytags.
The following sections will walk you through the different sections of the Setup Menu.

**User Security and Check In Users.**
To use Roll Call’s child check in/out system you must “sign into” the system as a check in user. The type of user determines the screens you will see. So the first thing you will need to do to activate the security system is to set up the “check in” type users.

**Activate Roll Call Security**
To activate the security system with in Roll Call you must give the Director/Administrator user a password. To do this:
1. Expand the Check In/Out menu.
2. Click on the Setup menu item.
3. Enter the password you’d like to give to Director. Then re-enter that password to confirm.
4. Click SAVE. Make sure to save this password before you click NEXT to go to the next step in the process.

**Create Check In Users**
After you’ve entered the Director password and clicked NEXT, you will be at the window to add check in users. To add a check in user, click on the plus sign in the lower left of the window. Enter the following information:
1. **Username** – enter the name for this specific check in user.
2. **Password** – enter a password for this specific user or leave it blank.
3. **Confirm** – re-enter the password if you entered one.
4. **Check In User (Client)** – make sure to mark this option if the user will be logging into a computer check in station.
5. **Check In User (Mobile)** – mark this option if you are creating a user that will be logging into a mobile device to perform check in through our Mobile Check In add-on.

6. **Print Queue User** – mark this option if you are creating a print queue user that will manage the nametag print jobs for mobile check in.

7. Click OK to save this user.

You are now taken to the window to select the properties for this check in user.

### Check In User (Client) - Options

If you are creating a check in user that will be used on a computer check in station, there are a variety of options that will affect what is displayed on the screen and how the check in station operates.

There are three tabs with different options. The Permissions tab allows you to define how the check in user will operate. The Check In Options tab will allow you to define which events/classes/groups are available to check into. The Appearance tab allows you to define color schemes, background image and logo.

On the Permissions tab, choose the following:

**Self Check In** – if the check in user has “self check in” marked, this user will not be able to view any address information from the people list screens. This user will not be able to print the check in roster or exit the program without a password. Use this option for “unmanned” stations.

**Dashboard** – if this option is marked, the check in screen will include a tab called Dashboard. When the user clicks on the Dashboard tab they will be able to view how many people have checked into each class today. They can further drill down and see who is checked into each class. We recommend using this option only for “manned” stations.

**Default Campus** - if system preferences are set to allow multiple campuses, each check in user can have a default campus defined. This means that the user will only be able to check into groups/classes/services that are from that campus. For example, if the check in user has a default campus “Southside”, they will only see groups that also have Southside as the campus.
Touch screen – if the check in user has “touch screen” marked, a virtual keyboard will be displayed on the screen.

Rapid Check In – if the check in user is marked as “rapid check in” and you are checking in by “individual” and the student is only enrolled in one class that is meeting that day, the system will automatically check them into that class.

Check-Out – if the check out option is marked, then that user can also check students out through the system.

Add Visitor – if the add visitor option is marked, there will be an ADD VISITOR button on the check in screen. This will allow the user to enter basic information about the visitor and check them into the appropriate class or meeting.

Edit Profile – if the edit profile option is marked, an EDIT PROFILE button will be included on the Options page so that the user can update a person’s profile information. For example if a student needed to update their email or address, this could be done through EDIT PROFILE.

Check In Using – if you are not using a bar code scan or fingerprint scan to identify who is there to check in, you will need to identify them based on their last name, last four digits of the phone number or the family number.

Return Families or Individuals – if you are doing a bar code scan or fingerprint scan and have “return by family” checked, a list of all the family members will be returned when you perform the scan. If you are searching by name, phone or family number, a list of families will be returned that meet the entered criteria. Then the user will need to highlight the appropriate family. Next a list of family members will be presented so you can choose the ones that will be checking in.

If you are doing a bar code scan or fingerprint scan and have “return by individual” checked, only the person assigned that bar code number (or fingerprint) will be returned. Typically you would use this to check students into a youth group or adult class.

If you are searching by name, phone or family number and have “return by individual” checked, a list of people that meet that criteria will be displayed. For example, if you search by name and enter “Smith”, a list of everyone who has the last name “Smith” will be returned. You can highlight one or more from the list to check them in.

List Only Children – if you are using the system to check kids into your Children’s Ministry or Daycare, you can limit the name that are returned to “only children”.

The Check In Options tab allows you to set which groups/classes will be displayed when the user hits the EDIT button. The different options are as follows:

- **Only show groups/classes a person is enrolled in.** This option will limit check in to only those classes that a child is pre-enrolled in or to recommended classes based on the age or grade range in the group definition.

- **Only show groups/classes currently available.** This option will limit check in to those classes that are currently meeting within the check in timeframe window.

- **Show all groups/classes meeting today.** This option will allow check in, into any classes/groups that are meeting today.
- Show only specified groups/classes. This option will allow you to choose the specific classes/groups that are available.

The Appearance tab allows you to set what the check in screen will look like. Your options are:

Check In Header – Enter the heading you’d like displayed on the Check In Screen as well as the Header font, size and color.

Check In Image – Click on the plus sign to pull in your logo as the check in image. This image will be displayed in the upper left of the check in screen.

Background Image – Use the drop down to select a stock photo as your background image. Or use the plus sign to pull in your own image.

Background Color – Select the color you’d like as the background on the check in screen if you did not choose a background image.

Once you have selected all the information necessary for your check in user, make sure to press the SAVE & CLOSE button.
Check In User (Mobile) - Options

If you are creating a check in user that will be used on a tablet or smartphone, there are a variety of options that will affect what is displayed on the screen and how the check in station operates. The Permissions tab allows you to set the options for how the check in station will operate.

Self Check In – if the check in user has “self check in” marked, this user will not be able to view any address information from the people list screens or edit profile information.

On Screen Keyboard – if the check in user has “On Screen Keyboard” marked, this will create a virtual keypad for the option to checkin using Search by Phone only.

Dashboard – if this option is marked, the check in screen will include a tab called Dashboard. When the user taps on the Dashboard tab they will be able to view how many people have checked into each class today. They can further drill down and see who is checked into each class. We recommend using this option only for “manned” stations.

Default Campus - if system preferences are set to allow multiple campuses, each check in user can have a default campus defined. This means that the user will only be able to check into groups/classes/services that are from that campus. For example, if the check in user has a default campus “Southside”, they will only see groups that also have Southside as the campus.

Check-Out – if the check out option is marked, then that user can also check students out of their classes through the system.

Add Visitor – if the add visitor option is marked, there will be an ADD VISITOR button on the check in screen. This will allow the user to enter basic information about the visitor and check them into the appropriate class or meeting.

Check In Using – Indicate if you will pull up students based on their name or phone number. With mobile check in users you can also check in by group, keyword, service or event (for more information on events see the Event Checkin Manual). If one of these options is chosen the system will present a list of people enrolled in that group/keyword or service and the user simply marks who is present.
Return Families or Individuals – If you select return families, a list of families will be returned with that have that last name or phone number. If you select return individuals, a list of individual people with that last name or phone number will be returned.

List Only Children – if you are using the system to check kids into your Children’s Ministry or Daycare, you can limit the name that are returned to “only children”.

Default Print Queue – Select which print queue the name tags and parent tags should go to for this mobile check in user. For example, let’s say we have some one checking in on the lower level with an iPad and another user checking in students on an iPad on the upper level. You can have two different printers … one on the lower level and one on the upper level. These printers will be defined as print queue users. You must associate the printer for each mobile user.

Choose which groups/classes should be displayed when you press EDIT.

The Check In Options tab allows you to set which groups/classes will be displayed when the user hits the EDIT button. The different options are as follows:

- *Only show groups/classes a person is enrolled in*. This option will limit check in to only those classes that a child is pre-enrolled in or to recommended classes based on the age or grade range in the group definition.

- *Only show groups/classes currently available*. This option will limit check in to those classes that are currently meeting within the check in timeframe window.

- *Show all groups/classes meeting today*. This option will allow check in, into any classes/groups that are meeting today.

- *Show only specified groups/classes*. This option will allow you to choose the specific classes/groups that are available.

Once you have selected all the information necessary for your check in user, make sure to press the SAVE & CLOSE button.

Check In User (Print Queue) - Options
If you are using Mobile CheckIn and would like to print nametags and parent tags, you’ll need to create a least one print queue user. There are two types of print queue users:
If this check in user will be used for printing Mobile Check In labels, mark Print Queue User.

Mark the options you'd like for this check in user.

1. Local print queue. With a local print queue you need to have a Dymo printer connected via USB to a computer that is running Roll Call and logged in as this print queue users.
2. Remote print queue. An example of a remote print queue would be a brother wireless printer. The brother printer driver must be installed on a computer that is logged into Roll Call.

Default Campus - if system preferences are set to allow multiple campuses, each print queue in user can have a default campus defined.

Once you have selected all the information necessary for your check in user, make sure to press the SAVE button.

**Name Tags & Parent Tags**

Use the “tags” section to set your preferences for printing name tags and parent tags. Once you hit next from the check in user screen, you will be asked if you want to print name tags upon check in. If you do, click Yes. Click NEXT

Next, you’ll be asked which size you’d like to use. We support 2 sizes. The 30256 is the larger shipping size label. The 30334 is a smaller multi-purpose label. You may also choose to create a custom label here. Make your selection, then click NEXT.

The next window asks if you’d like to print a parent tag for children. The parent tag lists only the security number that matches the child’s name tag. Parent tags are only printed for people in the database whose family position is Child.
Choose the size labels you’ll be using for name tags and parent tags.

If you choose to print parent tag, choose the security number you’d like to use.

Also on the screen you may indicate the number you’d like to use as the security number on the name tag and the parent tag. You may choose from the family number, a random security number that uses numbers and characters or a random security number that is strictly numbers. Click NEXT.

From this window, select the information you’d like printed on the child’s name tag.

1. **Logo** – if you are using the 30256 size labels, you can print a ministry logo in the upper left of the label. You don’t want this logo to be a super high resolution logo or it will take a long time to print.
2. **Barcode** – some churches print the barcode on the label itself for easy check out.
3. **Security number** - choose the security number you’d like printed on the child’s name tag. The badge number is not allowed if you will be printing parent tags. The badge number uniquely identifies the child. The family number is a number assigned to the family in roll call. The random security number is randomly determined by the system. The random number will change from week to week. The badge number and family number will not change from week to week.
Choose the information that should be printed on the child's tag.

4. **Allergies** – any allergies listed in the “Special Needs” comment section will be displayed on the name tag if this is checked.

5. **Last Name same size as First** – By default the first name is in a larger font that the last name. If you’d like them to be the same size, check this box.

6. **Session Time or CheckIn Time** – You can choose to print the class start time (session time) or the actual time that the child checked into the class on the name tag. Mark your selection.

When you’ve checked the options you’d like for the name tag, click NEXT to choose a logo for Youth and Adult name tags. The youth and adult name tags will only include their name, the date of the event and the group they are checking into. There is no security number, barcode or allergy information printed on an Adult tag.

To add a logo for the Youth/Adult tag, click the box for logo. Click the ADD IMAGE button and navigate to that image file. Click NEXT to continue through the check in set up process.

At this point you may want to install your Dymo printer and run a test label to make sure everything looks okay. Once you have the printer installed, click on the PRINT TEST button. If everything prints okay, click NEXT to continue through the set up process.

**Check In Preferences**

The check in preferences allow you to set the “check in timeframe”. You can set the number of minutes before a class, event, worship service starts you’d like to begin the check in process. You can also set the number of minutes before a class ends that you will no longer allow anyone to check into that class.

As an example, let’s say we have a Sunday school class that meets from 9:30 to 10:30, if we set our beginning time to 30 minutes before, we can begin checking kids in at 9:00 a.m. In this same example if we set the ending minutes to 15, we could check students into that class until 10:15. At 10:15 we would no longer see this class in our list of classes to check into.

On the Preferences screen you can also set the **default association** for visitors. This will be the association that is used in the ADD VISITOR screen.
Enter the number of minutes before a class starts to begin check in.

You may also customize the text on the Options screen. Enter that text in the field for Welcome Screen Text.

**Groups**

To use the child check in functionality, there must be something to check into. You can check people into Groups or Services. The Groups area in Roll Call is where you would set up your Sunday school classes, VBS, membership classes etc. The Services area is where you set up your worship services. Each group that you will be checking into must have at least 1 session. A session is the day and time that it meets. For example, if you had a first grade Sunday school class that meets at 9:30 and 11:00, those times would be the session.
To add a group through the check in setup area, click on the plus sign in the lower left corner. You are now at the window to add a group. For more details on creating groups, see the “Creating Groups” chapter in this manual.

People

You will also need to have at least your children entered into the system and enrolled into their classes to use the check in system. To enter people through the check in setup area, click the plus sign in the lower left corner. You are now at the people entry screen. For more details on entering people, see the “Entering People” chapter in this manual.

Click the plus sign to enter people into your database.

Place the cursor in the field to the right of the person's name you are assigning the tag to. Scan the tag.

Uncheck Auto Assign when assigning your own barcode numbers (from keytags) using barcode scanners.
Key tags

If you will be ordering key tags for use with the Roll Call child check in system, click NEXT from the People list in the set up process or click on the Key tags graphic. The first window asks if you’ll be using Key tags. If so, answer yes. If not, answer no. Make sure the Auto Assign at the bottom of the page is unchecked when assigning your own barcodes using keytags.

To assign a key tag to a person, highlight their name in the list. Click on their barcode number (assigned by roll call) Once that number is highlighted, scan the key tag. This will assign the new number to this person.
OPERATING THE CHECK IN STATIONS (Computer Stations)

Log into the Check In Station

To use the check in functionality of Roll Call, you need to log on with a username that is a check in user type user. To start Roll Call, double click on the Roll Call icon. The Login window is displayed. If you do not get the Login screen, that means the security system is not activated. You’ll need to give the Director user a password. See the chapter on “Configuring Roll Call for Check In/Out”.

If you are already logged into Roll Call, but are in the back end of the program where you look up people and groups, you can get into the Check In portion, by expanding the check in/out menu, then selecting Launch. This will bring you to the Login window so you can login as a check in user.

Once you log in, you’ll be taken to the check in screen. This screen can look different depending on the type of check in user you’ve signed in as. These options are discussed more in the chapter on “Configuring Roll Call for Check In/Out.

Check In Using a Last Name

To check a family in, based on their last name, type the last name. You can also type the first few characters of the last name. Then press the enter key or press the SEARCH button. This can be
done with a keyboard or with the virtual keyboard on a touch screen monitor. A list of families with that last name will be displayed. Highlight the family that is present to check in then press the SELECT button to get to the list of family members. If there is only one family with that last name the system will take you right to the list of family members.

To check in everyone listed, click CHECK-IN ALL. If you want to check in only certain children, click the checkmark to the right of their name. Once you’ve selected each child that will

Double click on the family that is present. Or highlight family and click SELECT.

Click CHECK IN ALL to check in both kids. Note the classes they will be checked into.

To check in only one of these students, click on the check mark to the right of their name. Click CHECKIN.
check in, press the CHECKIN button to complete the check in process. If you would like to change which class the child will go to, click on the EDIT button. A listing of classes available for check in will be displayed. Mark the class(es) they should go to and click DONE.

If the child is not enrolled in any classes that are currently meeting the Checking Into field to the right of their name will be blank. Click the EDIT button. A listing of all classes available for check in will be displayed. Mark each class you’d like to check the child into. Click DONE to return to the check in screen. Then click CHECK IN to complete the process.

**Check In Using a Phone Number**

To check a family in based on a phone number, enter the last four digits of their phone number and press the enter key on your keyboard or click the SEARCH button. The system will return a list of families that have those four digits in the primary phone, alternate phone, cell phone or work phone field for any member of the family. This can be done with a keyboard or with the virtual keyboard on a touch screen monitor.

A list of families with that phone number will be displayed. Highlight the family that is present to check in then press the SELECT button to get to the list of family members. If there is only one family with that phone, the system will take you right to the list of family members.

To check in everyone listed, click CHECK-IN ALL. If you want to check in only certain children, click the checkmark to the right of their name. Once you’ve selected each child that will check in, press the CHECKIN button to complete the check in process.
Enter last 4 of phone and press enter on your keyboard or click SEARCH.

Double click on the family that is present. Or highlight family and click SELECT.

Click CHECK IN ALL to check in both kids. Note the classes they will be checked into.
Note the class that the child will be checked into is listed under the Checking Into column. If you would like to change which class the child will go to, click on the EDIT button. A listing of classes available for check in will be displayed. Mark the class(es) they should go to and click DONE.

If the child is not enrolled in any classes that are currently meeting the Checking Into field to the right of their name will be blank. Click the EDIT button. A listing of all classes available for check in will be displayed. Mark each class you’d like to check the child into. Click DONE to return to the check in screen. Then click CHECK IN to complete the process.
Check in Using a Bar Code

From the check in screen, scan the bar code from the keytag or bar code badge. If the check in user is set to “return by family” all the family members associated with this bar code number will be displayed.

To check in everyone listed, click CHECK-IN ALL. If you want to check in only certain children, click the checkmark to the right of their name. Once you’ve selected each child that will check in, press the FINISHED button to complete the check in process.
Note the class that the child will be checked into is listed under the Checking Into column. If you would like to change which class the child will go to, click on the EDIT button. A listing of classes available for check in will be displayed. Mark the class(es) they should go to and click DONE.

If the child is not enrolled in any classes that are currently meeting the Checking Into field to the right of their name will be blank. Click the EDIT button. A listing of all classes available for check in will be displayed. Mark each class you’d like to check the child into. Click DONE to return to the check in screen. Then click CHECK IN to complete the process.

If the check in user has “return by individual” set, only the individual associated with that bar code will be displayed. If that user also has “rapid check in” set, that individual will automatically be checked into their class.

**Check In Using a Touch Screen**

To check in using a touch screen monitor, you’ll need to sign in using a check in user that has “touch screen” marked. For more information on setting up users, see the “Configuring Roll Call for Check In” chapter of this manual.
When you sign in as a check in user with the touch screen option, a virtual keyboard will be displayed on the screen. This will allow the user to enter a name or number using just the screen. Once they enter the criteria, they can press the SEARCH button on the screen instead of using the mouse. Once the lists are displayed, the process is the same as searching by name or phone.

Check in Options

Check into Different Class
From the list of family members, you’ll notice the Checking Into column. This column will list the classes, meetings and events that each person is enrolled in that are currently meeting. If you press the checkmark to the right of the person’s name, the system will check them into everything listed in that Checking Into column. If you would like to check them into a different class:
1. Press the EDIT button.
2. The classes listed are dependent on your settings for this check in user.
3. Mark the class this student will be attending. Make sure to un-check the classes they were slated to attend.
4. Click DONE to return to the Check in screen.
5. Repeat for each family member.
6. Click CHECKIN from the list of family members to complete the check in process.

Check into Multiple Classes
From the list of family members, you’ll notice the Checking Into column. This column will list the classes, meetings or events that each person is enrolled in that are currently meeting. If you press the checkmark to the right of the person’s name, the system will check them into everything listed in that Checking Into column. If you would like to check them into additional classes or events, do the following:
1. Press the EDIT button.
2. The classes listed are dependant on your settings for the check in user.
3. Mark each class you’d like to check this child into.
4. Click DONE to return to the check in screen.
5. Complete the check in process for all family members.
6. Click CHECKIN from the list of family members to complete the check in process.

Choose one or more classes to check this child into. Click DONE.
**Enter Allergy, Note, Custody Comment or Check In Alerts**

If you need to record any notes, allergy, custody comments or check in alerts for a student, do the following:

1. From the list of family members, click the options button (looks like a pencil) to the right of the student’s name.
2. Mark the class the student will be attending.
3. Enter any notes for today. The notes will be printed on the name tag and check in roster. They are not stored in the database.
4. Any allergy information that is already in the database will be displayed. If you need to update or add to that information, make those changes on the bottom section of the option screen.
5. If there are any custody comments in the database for this child, they will be displayed at the bottom of the options screen. If you need to add custody comments or update existing custody comments do that here.
6. Enter any CHECK-IN Alerts at the bottom of the options screen.
7. Once you’ve entered this information, click CHECK-IN to check the child into their class and save the updated information.

**Update Profile Information**

If you are logged onto the check in system as a user that has “Edit Profile” privileges you will be able to update general contact information for this student. To make those changes:

1. From the list of family members, click on the options icon to the right of the student’s name.
2. Click on the EDIT PROFILE button at the top of the window.
3. Make any necessary changes.
4. Click SAVE & CLOSE to save these updates.
Assign a Barcode

If you are handing out keytags at the check in station, you’ll need to assign the bar code number to that person/family.

1. From the list of family members, click on the options icon to the right of the student or parents name.
2. Click on the ASSIGN BARCODE button at the top of the window.
3. Scan the keytag.
4. Click OK to save that assignment.
5. Click CANCEL to return to the check in page, or CHECK-IN to check in the parent or student into their class.
Pull in a Picture
You can import an individual’s picture through the options window. From the list of family members, click on the options button (looks like a pencil) to the right of the student you wish to import a picture for. Click on the plus sign underneath the picture area. Navigate to the their picture on your computer. Click OPEN.

Add a New Person into an Existing Family
If you need to add a person to a family that already exists in your database, do the following:
1. From the main check in screen enter the last name of the family then click SEARCH.
2. From the list of family members, click ADD TO EXISTING FAMILY button.
3. Enter the information for the new family member.
4. Click SAVE & CLOSE to save the information and return to the list of family members to check them in.
5. Or, click ADD ANOTHER to add another family member.
Enter additional family members here.

Check in Visitors
To check visitors into a class or group, click on the ADD VISITOR button. Enter the address and phone information if you’d like. Next enter the Mom and Dad’s information if you’d like to capture that. In the lower section enter the children’s names. You can enter up to four children through this screen. Click OK to save this information.
Enter the visitor’s information here. At a minimum, you must enter children’s info.

Now you will be at the screen to highlight those that are present to check in. If you’ve entered a grade or birthdate for each of those children and your classes have a grade/age range preference, you’ll see a recommended class for each child in the Checking Into column. If those are in fact the classes you want to check them into, click CHECK IN ALL.

If you’d like to check them into a different class, click on the options button (looks like pencil). Choose the class/classes you’d like them to check into, click CHECK IN.

Note recommended classes.

Click CHECK IN ALL to check them into these classes.
Check In by Individual Using a Last Name or Phone

The check in by individual is a great option for checking in youth group students, event participants or day care students. It is for those times that you are not checking in multiple members of the same family… but just one person at a time.

If you check in user is defined to “check in by individual”, you can type in the first few character of the last name, then a comma, then the first few characters of the first name or the last 4 digits of a phone number. Then press the enter key or press the SEARCH button. This can be done with a keyboard/mouse or with the virtual keyboard on a touch screen monitor.

A list of individuals that met the name or phone criteria will be displayed. Highlight the person that is present to check in then press the SELECT button to get to check in screen. If there is only one person that met the criteria the system will take you right to the check in screen.

A list of all the classes the student is enrolled in, that are currently meeting will be displayed. Click on the checkmark to the right of each class you’d like to check them into. Then click on the CHECK IN button in the lower right.

Mark the box to the right of the class you’d like to check them into. Click CHECKIN.
If you would like to check the student into a completely different class, click on the hamburger button in the lower left. This will give you an option to choose “Additional Choices”. When you choose this option a list of all the classes available for check in will be displayed. Click on the checkmark to the right of the class, click CHECKIN to check them in.

Choose from these options to view additional classes or edit data.

To update allergy information, profile data, check in alerts or bar codes, simply click on the hamburger menu and choose the appropriate option. A window will be displayed for you to enter or modify that data.

This is the window that pops up when you choose the option for Editing the Profile.
Check in by Individual Using a Bar Code

The check in by individual is a great option for checking in youth group students, event participants or day care students. It is for those times that you are not checking in multiple members of the same family… but just one person at a time.

If you are using a check in user that is defined as “check in by individual”, and you scan a barcode or fingerprint, the system will take you directly to the check in screen. A list of all the classes the student is enrolled in, that are currently meeting will be displayed. Click on the checkmark to the right of each class you’d like to check them into. Then click on the CHECK IN button in the lower right.

If your check in user is also set to “Rapid CheckIn”, and the student is only enrolled in one class that is currently meeting, the system will automatically check them into that class.

If you would like to check the student into a completely different class, click on the hamburger button in the lower left. This will give you an option to choose “Additional Choices”. When you choose this option a list of all the classes available for check in will be displayed. Click on the checkmark to the right of the class, click CHECKIN to check them in.

To update allergy information, profile data, check in alerts or bar codes, simply click on the hamburger menu and choose the appropriate option. A window will be displayed for you to enter or modify that data.
Check into Services

You can set Roll Call up so that you can check people into worship services. First you’ll need to define the Service. To do this expand the Service menu and click Add Service. Enter the following information:

1. **Name** - Give the service a name.
2. **Day** – Select the day of the week this service meets.
3. **Start Time** – Enter the start time of the service.
4. **End Time** – Enter the ending time of the service.
5. **Check in** – Mark this box to allow automated check in to this service.
6. **Labels** – Indicate if you want name tags printed when someone checks into this service.
7. **Associations** – Enter the association of people that can check into this service.
8. **Click SAVE & CLOSE** to save this service.

Once you have the services set up for check in, you can check people into those services using any of the methods listed above.

Create the worship service that you’ll be checking in. Make sure to mark box for check in.

Note worship service is now listed for check in.
Determine Headcounts

There are two methods for determining who is checked into a class.
1. The dashboard tab.
2. The check in roster.

Dashboard

If you are logged onto the check in station as a user that has “dashboard” privileges, you will notice a check in and dashboard tab on your screen. Click on the Dashboard tab to view the counts for each class. The total count is the number of folks who have checked into a specific class. The head count is the number of students who are still checked into the class.

To drill down and view the details of who is in the class, double click on the class name, or highlight the class and click DETAILS.

Check In Roster

The check in roster is a report for a specific class, which lists the students who have checked in. The information included on this report is the child’s name, parent’s name, allergy information, notes, custody comments and birthdates. This is a great roster to print off after check in so that your teaches know who they are responsible for.

To generate the check in roster, do the following:
1. From the check in screen, select Administration>Check In Roster from the top menu.
2. Highlight one or more classes that you’d like to print the roster for.
3. Click GENERATE.

If you are printing this from one of the check in stations, don’t forget to change the printer you are sending it to. You don’t want this report printing off on your DYMO!
Once you choose Administration> Check In Roster, you’ll be at this screen. Highlight one or more classes, then click GENER-A TE.

Sample roster. Lists children, parents, allergies, security code and birthdate.

Check Out

Compare tags
Once method of Checking the students out is to compare the security number on the child’s name tag with the security number on the parent tag. If the numbers match the teacher can release the child.
Using this method, you will want to make sure to have policies in place to handle the circumstance where a parent loses the parent tag.
**Using Check In Screen**

You can also check students out through the Roll Call system. When they are logged out, the out time is recorded and any custody comments are displayed on the screen.

To log a student out:
1. Log onto Roll Call as a check in user that has “check out” privileges.
2. Identify the student that is Checking out by scanning a tag or by searching name or phone.
3. Highlight the specific family.
4. From the list of family members, click the check mark in the Out column.
5. If you have entered “authorized check out” person’s for this specific student, a screen will pop up asking you to pick who is Checking the child out.
6. Make your selection and click CHECKOUT.

![Using Check In Screen](image1.png)

Click check out button to check each student out of their class.

**Using Dashboard**

You can also check students out through the dashboard tab on the check in screen. When they are logged out, the out time is recorded and any custody comments are displayed on the screen.

To log a student out this way:
1. Log onto Roll Call as a check in user that has “check out” and “dashboard” privileges.
2. Click on the dashboard tab.
3. Click on the by person tab.
4. Scroll through the list of students that are checked in to find the student you wish to check out.
5. Click on the check out button (looks like an open door).
6. If you have entered “authorized check out” person’s for this specific student, a screen will pop up asking you to pick who is Checking the child out. Make your selection and click CHECKOUT.

![Using Dashboard](image2.png)

From the dashboard, you can click check out button to check a student out.
Sending Texts from Check In Screen

You can send texts from Roll Call’s check in system. To do this, you’ll first need to set up the texting preferences in Roll Call. There are two methods of sending texts from Roll Call. The first method is free and uses email to send the text. To use this method you will need to know the cell phone number plus the cell phone carrier. You will also need your Email Settings configured properly. The second method is to use the SMS Service from NexMo. Your church will need to set up an account with NexMo.

If authorized pick-ups are set for this student, this window will be displayed upon check out. Mark who is picking up.

My Email Settings

If your organization will be using the Email method of sending Texts, make sure to configure the following settings:
1. Expand the File menu from the top.
2. Select My Email Settings.
3. Choose your preference for Plain Text or HTML emails.
4. Enter the Return Address. This is the “from” email address. If a recipient replies to the email this is the email address it will go to.
5. Enter the Mail Host Name. This is the Outgoing SMTP mail address required by your email provider.
6. Enter the Username and Password for this email account if your provider requires authentication.
7. Mark the box for the SSL if your provider requires SSL encryption.
8. Enter the Port Number, if your provider requires a specific port number.
9. Enter the No Emails/Minute. Your provider may throttle the number of emails that you can send per minute. If so, enter that number here.
10. Click SAVE to save these settings.

Once your email settings areconfigured, go to the Preference (under the Edit menu on Windows or the Roll Call menu on a Mac). Click on SMS Texting on the left sidebar. Choose the option to use Email.

NexMo Settings

If your organization will be using the SMS service from NexMo, make sure to configure the following settings:
1. Select Preferences from the Edit menu at the top (Windows machines) or the Roll Call menu (Mac machines).
2. Highlight SMS Texting from the left sidebar.
Each Roll Call user must set their own outgoing email host settings.

3. Select the option to use NexMo.
4. Enter the API Key provided to your organization by NexMo.
5. Enter the Secret Key provided to your organization by NexMo.
6. Enter the NexMo number that was provided to your organization.

From the SMS Texting preference choose your method of sending texts.

7. Enter any Msg Prefix. This will be in front of every text that is sent.
8. Click OK to save this information.

**Sending the Text**

Once you have your preferences and settings configured, you are ready to send a text. To send a text from the check in system, do the following:

1. Click on the Dashboard tab.
2. Find the student you need to send a text for.
3. Click on the text icon.
4. Choose who you will send the text to.
5. Type in your text message.
6. Click OK to send the texts.
Find your Numbers and API key from the NexMo dashboard.

Find student then click text icon.
Write text message.

Choose who you'd like to send text to.
OPERATING THE CHECK IN STATIONS (Tablets)

Log into the Check In Station

To use the check in functionality of Roll Call on a tablet, you must have a Mobile Check In license or activated the trial for Mobile Check In. You will need to get to the login screen from your tablet’s browser. Do that by entering the IP Address of your Roll Call Server machine as the URL in your browser.

From the login screen, enter the user name that you created as your mobile check in user. Enter the password for that user. Choose “Tablet” as your App Format.

Once you log in, you’ll be taken to the check in screen. This screen can look different depending on the type of check in user you’ve signed in as. These options are discussed more in the chapter on “Configuring Roll Call for Check In/Out”.

Customizing the Appearance

You can customize the graphic that is displayed on the background of the check in screens as well as the login in screen. To customize, do the following:

1. Once you are logged onto the check in system, click on the gear in the upper right.
2. On the Users Settings tab:
   a. Use the drop down to select a background image.
   b. Enter the Checkin Header Text. This is the name at the top of the check in window.
   c. Tap CHOOSE FILE under Custom Background image to pull in your own image file for the background image.
   d. Tap CHOOSE FILE under Custom Logo to pull in your organization’s logo that will be displayed in the upper right of the check in window.
3. On the Theme tab:
   a. Use the drop down to select a pre-set theme. Each theme will change button colors, outline colors, etc.
   b. To build your own theme, click on the SET THEME BUILDER to paste in your own CSS code.
4. On the Login tab:
   a. Use the drop down to select a background image for the login in screen.
   b. Tap CHOOSE FILE under custom image to pull in a custom image for your log in screen.
5. Tap SAVE to save these customization preferences.
Check In Using a Last Name or Phone Number

To check someone in based on the last name or phone number, first create a mobile user. If you want to use the virtual keyboard, be sure to select Search by Phone then ON SCREEN keyboard selected. Using the virtual keyboard, enter the last four digits of any phone number. Then tap the GO button. This virtual keypad only works with the phone option selected on Mobile. To check in by last name, select Search by Last Name or search by Last Name and Phone. You will have to type in the information from your own device rather than use the virtual keypad.
Double click on the family you'd like to check in. OR highlight the family and click SELECT.

Tap on the checkmark to check the child into the class listed.

A list of families with that last name will be displayed. Highlight the family that is present to check in then tap the SELECT button to get to the list of family members. If there is only one family with that last name the system will take you right to the list of family members.

From the EDIT screen you may choose to check into a different class or multiple classes.
To check in everyone listed, tap CHECKIN ALL. If you want to check in only certain children, tap on the checkmark to the right of their name. Once you’ve selected each child that will check in, tap on the CHECKIN button to complete the check in process.

Note the class that the child will be checked into is listed under the Checking Into column. If you would like to change which class the child will go to, click on the EDIT button. All classes that are currently available to check into will be listed. Mark the class they should go to and click DONE to return to check in window. Click CHECKIN to complete the process.

If the child is not enrolled in any classes that are currently meeting the Checking Into field to the right of their name will be blank. Click the EDIT button and choose the class you’d like to check them into. Click DONE to return to the check in screen. Click CHECKIN to complete the process.

Check in Options

Check into Different Class
From the list of family members, you’ll notice the Checking Into column. This column will list the classes, meetings and events that each person is enrolled in that are currently meeting. If you tap the checkmark to the right of the person’s name, the system will check them into everything listed in that Checking Into column. If you would like to check them into a different class:
1. Tap the EDIT button.
2. All classes that are currently available for check in will be listed.
3. Mark the class this student will be attending. Make sure to un-check the classes they were slated to attend.
4. Tap DONE button to return to the check in screen.
5. Repeat for each family member.
6. Click CHECKIN from the list of family members to complete the check in process.

Check into Multiple Classes
From the list of family members, you’ll notice the Checking Into column. This column will list the classes, meetings or events that each person is enrolled in that are currently meeting. If you tap the checkmark to the right of the person’s name, the system will check them into everything listed in that Checking Into column. If you would like to check them into additional classes or...
Enter all allergy and notes information in this section.

events, do the following:

1. Tap the EDIT BUTTON.
2. All classes that are available for check in will be listed.
3. Mark each class you’d like to check this child into.
4. Touch the DONE button.
5. Complete the check in process for all family members.
6. Click CHECKIN from the list of family members to complete the check in process.

Enter Allergy, Note, Custody Comment or Check In Alerts

If you need to record any notes, allergy, custody comments or check in alerts for a student, do the following:

1. From the list of family members, tap the EDIT button to the right of the student’s name.
2. Mark the class the student will be attending.
3. Enter any notes for today. The notes will be printed on the name tag and check in roster. They are not stored in the database.
4. Any allergy information that is already in the database will be displayed. If you need to
Update the necessary contact information.

Update Profile Information

If you would like to update general contact information for this student, tap on the EDIT PROFILE button. To make those changes:

1. From the list of family members, click on the EDIT button to the right of the student’s name.

Click ADD TO FAMILY to add other children to this family.

Click CHOOSE FILE to pull in a picture from your device.

If there are any custody comments in the database for this child, they will be displayed at the bottom of the options screen. If you need to add custody comments or update existing custody comments do that here.

6. Enter any CheckIn Alerts at the bottom of the options screen.

7. Once you’ve entered this information, click DONE to save the updated information. From the check in screen, click CHECKIN to complete the check in process.

Once you’ve entered this information, click DONE to save the updated information. From the check in screen, click CHECKIN to complete the check in process.
Enter the new family member's information. Click FINISHED or ADD ANOTHER.

2. Click on the EDIT PROFILE button at the top of the window.
3. Make any necessary changes.
4. Click SAVE & CLOSE to save these updates.

Click ADD VISITOR.

Enter the name and information for the first person in the family. Click ADD ANOTHER.
Pull in a Picture

You can import an individual’s picture through the options window. From the list of family members, click on the EDIT button to the right of the student you wish to import a picture for. Tap on the CHOOSE FILE underneath the picture area. Navigate to their picture on your device. Click OPEN.

Add a New Person into an Existing Family

If you need to add a person to a family that already exists in your database, do the following:
1. From the main check in screen enter the last name of the family then click GO.
2. From the list of family members, click ADD TO EXISTING FAMILY button.

Check In by Individual Using a Last Name or Phone

The check in by individual is a great option for checking in youth group students, event participants or day care students. It is for those times that you are not checking in multiple members of the same family… but just one person at a time.

Enter Last Name, comma, First couple of letters or you can enter last 4 of phone.
If you check in user is defined to “check in by individual”, you can type in the first few character of the last name, then a comma, then the first few characters of the first name or the last 4 digits of a phone number. Then press the enter key or press the SEARCH button. This can be done with a keyboard/mouse or with the virtual keyboard on a touch screen monitor.

A list of individuals that met the name or phone criteria will be displayed. Highlight the person that is present to check in then press the SELECT button to get to check in screen. If there is only one person that met the criteria the system will take you right to the check in screen.

Tap the check mark to the right of the class, then CHECKIN to check into that class.

A list of all the classes the student is enrolled in, that are currently meeting will be displayed. Click on the checkmark to the right of each class you’d like to check them into. Then click on the CHECK IN button in the lower right.

If you would like to check the student into a completely different class, click on the hamburger button in the lower left. This will give you an option to choose “Additional Choices”. When you choose this option a list of all the classes available for check in will be displayed. Click on the checkmark to the right of the class, click CHECKIN to check them in.

Tap on the hamburger menu and choose Additional Choice to view other classes available.
To update allergy information, profile data, check in alerts or bar codes, simply click on the hamburger menu and choose the appropriate option. A window will be displayed for you to enter or modify that data.

**Check In by Group or Event**

If you would like to view a roster of students enrolled in a class and have the ability to mark them present, you will want to check in by group. This method records check in and check out times, but it does not print name tags and it does not allow for the entry of visitors.

To check in by group or event, you’ll need to log onto your tablet as a mobile check in user that has the preference to “check in by group” or “check in by event”. For more information on creating users, see the chapter on “Configuring Child Check In”.

---

**Select the group or class you’ll be checking folks into.**

**From the hamburger menu, choose allergies. This window will be displayed to enter allergy information.**
3. Enter the child’s name at the bottom of the window.
4. Tap ADD ANOTHER to add additional family members.
5. Tap FINISHED to save the information and return to the list of families to check them in.

Click on checkmark to the right of a student's name to check them in.

Check in Visitors

To check visitors into a class or group, click on the ADD VISITOR button. Enter the name of the first person in the family. Click ADD ANOTHER to enter the next person in the family until everyone is entered. Make sure the children you’ll be checking in have a family position of CHILD. Once you’ve entered everyone, tap FINISHED. Now you’ll be taken to an area where you can enter the address and phone information for this family. Enter that, then tap CONTINUE.

Now you will be at the screen that lists all family members. If you’ve entered a grade or birthdate for each of those children and your classes have a grade/age range preference, you’ll see a recommended class for each child in the Checking Into column. If those are in fact the classes you want to check them into, tap CHECK IN ALL.

Choose the worship service you'll be recording attendance for.
Tap the check mark to the right of the family to check in entire family.

Tap on family name to view list of all family members. Click on checkmark to right of family member to check them in.

If you’d like to check them into a different class, tap the EDIT button. Choose the class/classes you’d like them to check into, click DONE to return to the check in screen. Once you’ve completed this process for everyone, click CHECKIN to complete the process.

Once you’ve logged onto the check in system on your tablet, you’ll have a drop down list of all groups/classes that are currently meeting. Choose your class. You’ll be presented with a list of students in that class. Tap on the check mark to the right of their name to check them in. Tap on check out (open door) to check them out of the class.

**Check In by Service**

If you would like to view list of people from your database and have the ability to mark them present at a worship service, you will want to check in by service.

To check in by service, you’ll need to log onto your tablet as a mobile check in user that has the preference to “check in by service”. For more information on creating users, see the chapter on “Configuring Child Check In”.

60
All students with that keyword are listed.

Mark check mark to check them into the class listed.

Once you’ve logged onto the check in system on your tablet, you’ll have a drop down list of all services that are currently meeting. Choose your service. You’ll be presented with a list of families that have the associations you selected for that service. Press the check mark to the right of the family to mark each person in the family present. Tap on the family name, to select specific individuals in that family to mark them present.

Note the total count in the upper right of the window. That indicates how many people you have.

Note dashboard tab.

Each class is listed with head count information.

All children currently checked into class are listed.
marked as present. If you need to add to that number to get to the real head count, add that in the field underneath.

**Check In by Keyword**

The check in by keyword allows you to check in folks that have a specified keyword. This is a great option for managing bus ministries. You could have all the students that are on bus route 1 assigned that “bus route1” as a keyword. The bus driver can log in as the mobile check in user for keyword bus route1.

Once he logs in, it will return a list of students that have “bus route 1” as their keyword. Notice the Checking Into column. This will denote the class this child is enrolled in. To check the child in, tap the check mark to the right of the name. Click PRINT LABELS to send the nametags for the checked in kids to the printer.

**Determine Headcounts**

Notice the dashboard tab in the upper left of your window. This tab is not available for “self check in” users. Tap on the dashboard tab to view the counts for each class. The total count is the number of folks who have checked into a specific class. The head count is the number of students who are still checked into the class.

To drill down and view the details of who is in the class, tap the DETAILS button to the right of the group/class name.
Choose the authorized person that is checking the child out.

Check Out

Compare tags
One method of checking the students out is to compare the security number on the child’s name tag with the security number on the parent tag. If the numbers match the teacher can release the child.

Using this method, you will want to make sure to have policies in place to handle the circumstance where a parent looses the parent tag.

Using Check In Screen
You can also check students out through the Roll Call system. When they are logged out, the check out time is recorded and any custody comments are displayed on the screen.
Choose the authorized person that is checking the child out.

To log a student out:
1. Log onto Roll Call as a check in user that has “check out” privileges.
2. Identify the student that is checking out by searching name or phone.
3. Highlight the specific family.
4. From the list of family members, click the check mark in the out column. Click CHECKOUT.
5. If you have entered “authorized check out” person’s for this specific student, a screen will pop up asking you to pick who is checking the child out.
6. Make your selection and tap CHECKOUT.

Using Dashboard
You can also check students out through the dashboard tab on the check in screen. When they are logged out, the out time is recorded and any custody comments are displayed on the screen.

To log a student out this way:
1. Log onto Roll Call as a check in user that has “check out” privileges.
2. Tap the dashboard tab.
3. Click on the by person tab.

From the Roll Call Preferences window, choose NexMo as your SMS texting options.
Find your Numbers and API key from the NexMo dashboard.

4. Scroll through the list of students that are checked in to find the student you wish to check out.
5. Tap on the check out button (looks like an open door).
6. If you have entered “authorized check out” person’s for this specific student, a screen will pop up asking you to pick who is checking the child out. Make your selection and click CHECKOUT.

**Sending Texts from Check In Screen**

Using Mobile CheckIn, you must use the SMS service NexMo to send texts through the tablet.

Tap the text button to the right of the student's name that you need to send a text for.
Enter text message.

Choose who to send text to.